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Changes in v1.5
In the ßeta3 driver, there was a delay of several hundred samples at the beginning of a recorded audio file. Maximum record
latency, which is different than record monitor latency, is now under 10 samples.

●   

When recording through either the analog or digital inputs, you can play and record monitor through both the analog and
digital outputs.

●   

The Large buffer setting has been removed. The Medium buffer setting (1024 samples) is now the default, recommended
setting.

●   
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Introduction
The Digidesign WaveDriver is a two-channel, multimedia wave driver for Digidesign's AudioMedia III card. This wave driver allows
third-party audio applications to utilize the AMIII for two-channel recording and/or playback. It is compatible with Windows 98 and
Windows 98 SE and supports only one AMIII card.

Full-duplex recording and playback of 24- and 16-bit audio are supported at sample rates of 48000 Hz, 44100 Hz, 22050 Hz, and
11025 Hz. (When recording and playing 24-bit files via the analog I/O, only 18 bits of audio are actually used.) Other word lengths
and sample rates are available through the Microsoft Sound Mapper.

Also included is the DigiGain volume control application. DigiGain allows control over the wave driver's master output volume and
input/record monitoring levels. DigiGain has no effect on recording/playback in any application that communicates with Digidesign
hardware via Digidesign's Direct I/O standard.

Installing the WaveDriver

**IMPORTANT**

http://www.digidesign.com/serv/readme/wvdrv/AM3WaveDriverWin98ReadMe.pdf
http://www.digidesign.com/serv/ftpmaps/wavdrv.html


Digidesign Session for Windows, the Digidesign Audio Engine (DAE), and previous versions of the AMIII WaveDriver will not work or
even co-exist on your computer with the AMIII WaveDriver version 1.5 . Before installing the AMIII WaveDriver version 1.5 , these
older drivers must be removed.

The v1.5 WaveDriver is not compatible with the "NTFS for Win98" driver available at
http://www.winternals.com/products/win98.shtml . Win98 will crash on launch if both drivers are installed. You must uninstall the
NTFS driver before installing the v1.5 WaveDriver.

If you have previously installed the ßeta3 driver or an earlier beta version, you must completely remove it before installing the AMIII
WaveDriver version 1.5. See Removing the WaveDriver below for instructions on removing beta versions of the driver.

*********************

Removing the version 1.3 AMIII WaveDriver
From the Start menu, choose Settings > Control Panel > Multimedia.●   

Click on the Devices Tab.●   

Open Audio devices.●   

Double-click on the Digidesign WaveDriver to open the Advanced Properties box.●   

Click Remove and confirm that you want to remove the driver.●   

Click OK to close the Multimedia control panel.●   

Restart Windows 98.●   

From the Start menu, choose Find > Files or Folders.●   

Search for the following files in the root directory of C:\ and delete each one that is found.●   

DigiWave.drv●   

DigiWave.001●   

DigiSystem.dll●   

DigiWave16Assist.dll●   

DigiWave32Assist.dll●   

DigiDialogAssist.dll●   

Vdaed.vxd●   

Restart Windows 98 and proceed to Installation Instructions.●   

Removing Session / DAE
From the Start menu, choose Find > Files or Folders.●   

Search for the following files in the root directory of C:\ and delete each one that is found.●   

Sesthunk.dll●   

AM3_dsp.dll●   

Dae.dll●   

DigiSystem.dll●   

DigiWave16Assist.dll●   

Vdaed.vxd●   

Restart Windows 98 and proceed to Installation Instructions.●   

 

Installation Instructions
Shut down your computer and unplug it.●   

Install the AMIII card and make any necessary audio connections.●   

Plug in and turn on your computer.●   

Windows 98 will automatically detect the new hardware you installed.●   

In the Add New Hardware Wizard dialog, select "Display a list of all the drivers in a specific location, so you can select the
driver you want."

●   

Click OK.●   

Select "Sound, video and game controllers" as your device type.●   

http://www.winternals.com/products/win98.shtml


Click Next.●   

When prompted to select the manufacturer and model of your hardware device, click on Have Disk.●   

In the Install from Disk dialog, click on Browse.●   

In the Open dialog, browse to the location of DALWDM.INF in the wave driver installation directory.●   

With DALWDM.INF selected, click OK to close the Open dialog.●   

Click OK to close the Install from Disk dialog.●   

In the Select Device dialog, select "Show compatible devices."●   

Select the "Digidesign Audiomedia III" as your device.●   

The Add New Hardware Wizard dialog will say "Windows is now ready to install the selected driver for this device."●   

Click Next.●   

The actual wave driver installation will occur now.●   

You may see the following dialog: "DigiProx: Cannot run with this version of XXXXX.dll." Please follow the instructions on the
dialog.

●   

The Add New Hardware Wizard dialog will say, "Windows has finished installing the software you selected that your new
hardware device requires."

●   

Click Finish.●   

(If you saw the DigiProx dialog above, please restart Windows now.)●   

From the Start menu, choose Settings > Control Panel > Multimedia.●   

Click the Audio tab.●   

Click on the preferred device option menus for playback and recording. Observe if there are any other wave drivers installed
in addition to the Digidesign AMIII.

●   

Make sure "Digidesign AMIII: Ch 1-2" is chosen as your preferred device for both playback and recording.●   

If you do not see "Digidesign AMIII: Ch 1-2" in the preferred device lists, please close the Multimedia control panel and restart
Windows 98. After restarting, please launch the Multimedia control panel again and select the AMIII as your preferred device
for playback and recording.

●   

Click OK to close the Multimedia control panel.●   

If there are any other wave drivers installed on your system, and if you just selected the AMIII as your preferred device,
please restart Windows now. (The AMIII will not be truly set as your preferred playback and recording device until you reboot.)

●   

You are now ready to use the AMIII with your favorite audio applications. Refer to How to Change WaveDriver Settings for
help on configuring the AMIII driver. Refer to Known Issues for recommended settings for Windows and various audio
applications.

●   

File Specifics

The wave driver installation consists of the following files:

In Windows\System,
Digi32.dll v. 1.5.0.234●   

Digi16.dll (no version resource supported)●   

DigiMM.dll v. 5.0.1.234●   

Dalvxd.vxd v. 5.0.1.234●   

DigiProx.exe (no version resource supported)●   

DirectIO.dll v. 5.0.1.234●   

DSI.dll v. 5.0.1.234●   

DigiUI.dll v. 5.0.1.234●   

Mfc42.dll 4/23/99, v. 6.00.8447.0●   

Msvcrt.dll 4/23/99, v. 6.00.8397.0●   

In Windows\System32\Drivers,
Dalwdm.sys v. 5.0.1.234●   

In Windows\Inf\Other,
DigidesignDALWDM.inf●   

 



Removing the WaveDriver
Right-click My Computer and choose Properties (or open the System control panel).●   

Click the Device Manager tab.●   

Make sure "View devices by type" is selected.●   

Expand the Sound, Video and Game controllers branch.●   

Select the Digidesign AudioMedia III entry.●   

Click Remove, and confirm that you want to remove the device.●   

Click OK to close the System control panel dialog.●   

In Explorer, find Windows\Inf\Other\DigidesignDALWDM.inf and delete it.●   

Restart Windows 98.●   

NOTE: Files listed under File Specifics are NOT automatically deleted when removing the wave driver. If you wish to delete
them, we do NOT recommend deleting Mfc42.dll or Msvcrt.dll because these DLLs are shared with other applications.

●   

 

How to Change WaveDriver Settings
After installing the wave driver, you may access its settings as follows:

From the Start menu, choose Settings > Control Panel > Multimedia.●   

Click on the Devices Tab.●   

Open "Digidesign Multimedia Devices" and click the Properties button.●   

In the Digidesign WaveDriver Properties dialog, click the Settings button.●   

You should now see the following WaveDriver Settings Dialog:●   

 

WaveDriver Settings Dialog

Note that you cannot access the WaveDriver Settings dialog under the following circumstances:
When playing or recording in another audio application.●   

When using another audio application such as Acid or Cubase VST that has an option to keep the wave driver "open" even
when you are not playing or recording. (You must close the audio application before you can open the WaveDriver Settings
dialog.)

●   

Buffer Size control

When you play a file from a client audio application, the client app divides the file into little chunks (buffers) and sends each of these
to the wave driver. The wave driver copies the client app's buffers to the AMIII's own buffers in a double-buffering scheme. The
Buffer Size control in this dialog allows you to set the size of each of the two buffers the wave driver uses on the AMIII. You may
choose from the following buffer sizes:

Small = 512 samples●   

Medium = 1024 samples (default)●   

Small buffers have the advantage of low latency in the record monitor path. (Latency is the time delay between a signal entering the
audio inputs and leaving the outputs during recording.) Larger buffers have the advantage of making the wave driver more immune
to audio dropouts during playback/recording. In some audio applications, notably Sound Forge, performing various tasks such as
maximizing or minimizing windows will interrupt the wave driver and create glitches in the audio. The Medium buffer size is the
default, recommended setting.



Ch 1-2 Format control

Here you may choose between Analog and Digital I/O. When set to Analog, you can record into the analog RCA inputs. When set to
Digital, you can record into the digital S/PDIF RCA inputs. [See Sync Mode in the I/O Setup Dialog description below for info on
syncing to the digital input stream.] In either mode, you can play and record monitor through both the analog and digital outputs.

NOTE: Playback and record monitoring of 11025 Hz files through the Digital outputs is not supported. If you select Ch 1-2 Format to
be Digital and play an 11025 Hz file, you will not hear anything.

Pressing the OK button will cause settings to be saved in the registry when you shut down or reboot Windows. Pressing Cancel
restores settings to what they were before this dialog was opened. The OK and Cancel buttons in this dialog have no effect on
whether settings are saved or restored in the I/O Setup and Other Options dialogs described next.

I/O Setup Dialog

Click the Advanced button in the WaveDriver Settings to open the I/O Setup dialog:

No Interface tab

Peripheral Type

This will say "No Interface." The AMIII does not use an external interface.

Sample Rate

Available sample rates are 48000 Hz, 44100 Hz, 22050 Hz, and 11025 Hz. You do not need to change the sample rate in this dialog
before playing/recording a file with a new sample rate. If you are playing a file, it will automatically play back at the correct sample
rate. If you are recording a new file, simply choose the desired sample rate using the audio application's Preferences or Record
Options dialog.

For information on playing or recording files at unsupported sample rates, see Known Issues, General, Unsupported Sample Rates
below.

Sync Mode

The most common setting you will use in the I/O Setup dialog is Sync mode. Sync mode may be set to Internal or Digital and is
Internal by default.

Sync mode will automatically be set to Internal if you (1) select a sample rate here of 11.025 and 22.05 kHz, or (2) play or record a
file at one of these two sample rates. Note that a Sync mode setting of Digital will be lost if you have chosen the Windows Default
sound scheme for your system sounds. If you set the sample rate to 44.1 or 48 kHz, set the Sync mode to Digital, and reboot, the
wave driver will play the 22.05 kHz "Start Windows" sound and automatically change the Sync mode to Internal. If you often use
Digital sync, you may want to turn off system sounds (by choosing the No Sounds sound scheme) or choose 44.1 kHz system
sounds instead. You may change sound schemes by clicking the Start Menu, choosing Settings, selecting Control Panel, and from
there selecting the Sounds control panel.



Digital Format

This is set to S/PDIF by default and cannot be changed.

Ch 1-2 (Format)

This setting is different than the Ch 1-2 Format in the WaveDriver Settings dialog. It cannot be changed and should be ignored.

 

Card Info tab

Bus, Slot Number

These controls display card specific PCI bus information and should not be altered.

Other Options Dialog

Clicking Other Options in the I/O Setup dialog displays the following dialog:

Here you may select your Input Gain, Output Gain, and S/PDIF I/O type. (Master Level and Record Monitoring Level are accessible
via DigiGain, which is explained below.) At the top of the dialog, you can see whether S/PDIF mirroring is currently enabled or
disabled. Because S/PDIF mirroring is automatically set based on the Ch 1-2 Format in the WaveDriver Settings dialog, the S/PDIF
mirroring checkbox has been grayed out.

The default Input Gain is 0 dB. The default Output Gain is 0 dB. The default S/PDIF I/O mode is Tascam.

Note: If you exit from this dialog using the [ESC] key, any changes you made to its settings WILL be saved.

 

Installing DigiGain
DigiGain is an optional volume control applet that allows you to control the master output of the AMIII as well as control the
monitoring input levels of the wave driver independently from your third party audio application. By default, the master level is set to
-6 dB.

DigiGain is not available as a volume control on the Windows task bar. As a result, some settings will be disabled in the Multimedia
control panel (Audio tab). "Show volume control on the taskbar", the playback volume control, and the recording volume control will
all be disabled.

Before installing DigiGain

The wave driver must be installed before installing DigiGain. If you did not install the wave driver or reboot the computer after
installing the wave driver, do so now.

Installation Instructions
Navigate to the DigiGain Installer folder●   



Double click on Setup.exe●   

Follow the install instructions●   

Once the install is complete, reboot the computer●   

Removing DigiGain
Open up the Add/Remove Programs Control Panel (Start>Settings>Control Panel> Add/Remove Programs).●   

Select Digidesign DigiGain application●   

Press the Add/Remove button and follow the directions.●   

 

How to Use DigiGain

The behavior of DigiGain is dependent on the Ch 1-2 Format setting in the WaveDriver Settings dialog. If Ch 1-2 Format is set to
Analog, DigiGain will control volume of signals going to both the Analog and Digital outputs. If Ch 1-2 Format is set to Digital,
DigiGain will only control the volume of signals going to the Digital outputs.

Master Level

This slider adjusts the output volume of channels 1-2 of the AMIII. The default master level is

-6dB. NOTE: During recording, this does NOT affect the audio data being recorded.

Master Mute

The master mute checkbox, when checked, mutes all output of channels 1-2 of the AMIII.

Record Monitor Level

These sliders adjust the output monitoring level of the left and right recording channels.

NOTE: As with the Master Level slider, these sliders do NOT affect the audio data being recorded.

Record Monitor Mute

The Mute buttons under the Record Monitor Level sliders individually mute the left and right recording streams.



Gang

The Gang button groups the left and right Record Monitor Level sliders and Mute buttons.

 

Clicking on the OK button saves the volume settings. Volume settings are stored in a registry key. This allows you to maintain the
same volume level upon the next reboot or startup of the system.

 

Known Issues:
General

Unsupported Sample Rates

To play or record files at an unsupported sample rate such as 32 kHz, you must use the Microsoft Sound Mapper. To enable Sound
Mapper,

From the Start menu, choose Settings > Control Panel > Multimedia.●   

Click on the Devices Tab.●   

Open Audio devices and select Digidesign Multimedia Devices.●   

Click the Properties button.●   

Make sure "Do not map through this device" is NOT checked.●   

You may have to disable Sound Mapper for any other wave drivers you have installed by checking this option for those
devices.

●   

Next, launch your preferred audio application, go to its audio options menu, and select Sound Mapper as your audio device for
playback and recording. You may see Sound Mapper referred to as "Wave Mapper" in some applications. Your system is now
configured to record and play at sample rates unsupported by the wave driver.

However, if you often need to create files at an unsupported sample rate, you will probably achieve the highest audio quality via
another procedure. Select the Digidesign wave driver as the audio device for recording in your audio application. (Leave the Sound
Mapper as your preferred playback device.) Record your audio at a higher sample rate than your final desired rate. If your desired
rate is 32 kHz, recording at 48 kHz is preferable to 44.1 kHz for the best quality. After your audio is recorded, use your audio
application to convert the file to the desired sample rate. In Sound Forge, go to the Process menu and select "Resample". In
CoolEdit Pro, go to the Edit menu and select "Adjust sample rate...". These sample rate conversion routines usually create audio
files of higher quality than those recorded using Sound Mapper. Sound Mapper will still be required for playback -- but not recording
and playback.

Window Operations

Clicking on the minimize, maximize, or restore buttons or pressing the right mouse button for an options menu may result in audible
artifacts or stops during playback or recording. The recommended course of action is to avoid minimizing/maximizing during
playback and recording. Increasing the buffer size in the WaveDriver Settings dialog may help alleviate these problems.

Sample Rate Changes

Whenever you change sample rates, the AMIII will produce a small pop on its outputs. When you start playing or recording a file with
a new sample rate, you will hear this pop followed by a delay of about one second before playback/recording commences. Neither
the pop nor the period of silence will show up in the recorded file.

Recommended System Settings

IDE Disk Drive Mode

By default, Windows 98 configures IDE drive controllers to run in "PIO" mode. This mode causes disk accesses to consume
relatively large chunks of CPU time. This in turn can interfere with the wave driver's audio performance. Even if the audio files exist
on a SCSI drive, merely having a PIO-mode IDE drive in your system can be problematic for the wave driver.

The solution is to switch all IDE drives to "DMA" mode, a mode that consumes very little CPU time and is available with most IDE
drives. To switch your drives to "DMA" mode:

Right-click on My Computer and select Properties. (Alternatively, open the System control panel.)●   

Click the Device Manager tab.●   

Under the Disk Drives branch, select the IDE drive(s) you are using.●   

Click on Properties.●   



On the Settings page of the disk's properties dialog, make sure the "DMA" option is enabled.●   

Repeat for all IDE drives in your system.●   

Shut down or Restart Windows 98.●   

System Sounds

We recommend not associating system sounds with the "Select", "Open Program", and "Close Program" events. (System sounds
are accessible via the Sounds control panel.) The Windows Default sound scheme does not have sounds associated with these
events by default.

If you often encounter "Error -6010: Cannot Acquire Hardware" errors, and "Digidesign AMIII: Chan 1-2" is chosen as your preferred
playback and/or recording device in the Multimedia control panel (Audio tab), turning off system sounds may fix the problem. To turn
off system sounds, go to the Sounds control panel and select "No Sounds" as your sound scheme. Press OK to save your settings
and restart Windows 98. Alternatively, you may play system sounds through another soundcard on your system. To do this, make
sure your other soundcard is chosen as your preferred playback and recording device in the Multimedia control panel. Restart
Windows 98 and select system sounds to be played through this soundcard from the Sounds control panel.

(If this attempted fix to the Error -6010's does not work, please see the WaveDriver Settings dialog section about workarounds to
situations in which the WaveDriver Settings dialog cannot be opened.)

 

Known Issues with Common Audio Applications

------------------------------------------------------------------------------------------------------------------------------

Cakewalk Pro Audio 8.0, 9.0

------------------------------------------------------------------------------------------------------------------------------

Recommended Settings
You may need to exit and restart Cakewalk in between making these changes to its audio setup.❍   

CWPA 8.0:
Go to Tools | Audio Hardware.❍   

In the Audio Hardware dialog, select "Windows Sound Cards (DirectShow 5.1)." DO NOT select "Digidesign
AudioMedia 3" or "Digidesign Session 8."

❍   

Go to Tools | Audio Options.❍   

In the Audio Options dialog, select the Drivers tab.❍   

"Digidesign AMIII: Chan 1-2" should be enabled for both input and output drivers.❍   

Select the General tab.❍   

"Digidesign AMIII: Chan 1-2" should be set for the Playback and Record Timing Masters.❍   

Select the Advanced tab.❍   

"Enable Simultaneous Record/Playback" should be checked.❍   

"Use Wave Out Position for Timing" should be checked.❍   

"Use unpacked 32-bit storage for > 16-bit audio" should NOT be checked.❍   

Set Wave queue buffers = 4 and Wave buffer size = 100KB. More buffers or a larger buffer size may allow you to have
more tracks in your session. We get 8 tracks of 24-bit audio with this setting.

❍   

Press OK to close the dialog and save your settings.❍   

CWPA 9.0:
If you are installing CWPA 9.0 after CWPA 8.0, we recommend removing 8.0 first rather than installing 9.0 over it. In
our internal testing, installing 9.0 over 8.0 resulted in a maximum audio track count of 2 (!). If we uninstalled 8.0 before
installing 9.0, we could play as many as 8 24-bit tracks. We do not know the cause of this difference in performance
but we do know that uninstalling 8.0 first fixed it.

❍   

Go to Options | Audio and select the Drivers tab.❍   

"Digidesign AMIII: Chan 1-2" should be enabled for both input and output drivers.❍   

Select the General tab.❍   

"Digidesign AMIII: Chan 1-2" should be set for the Playback and Record Timing Masters.❍   

You will have to experiment with "[Number of] Buffers in Playback Queue" and "Buffer Size" to find the best settings for
your system configuration.

❍   



Select the Advanced tab.❍   

"Simultaneous Record/Playback" should be checked.❍   

"Stop On Driver Underrun" should be probably be checked. See Cakewalk help for more details.❍   

"WavePipe(tm) Acceleration" should NOT be checked. Cakewalk's WavePipe technology is not compatible with the
AMIII driver.

❍   

"Unpack >16 bit audio" should NOT be checked.❍   

"Left-justify unpacked data" should NOT be checked.❍   

Select the Device Profiles tab and select the "Digidesign AMIII: Chan 1-2" profile.❍   

"Use Wave Out Position for Timing" should be checked.❍   

Press OK to close the dialog and save your settings.❍   

 

Cakewalk 8.0 hangs or crashes when you record enable an audio track (more likely) or press Play or Record
(less likely)

Description
Cakewalk may hang or crash if you record enable an audio track or press Play/Record in one of the following
situations:

❍   

(1) The WaveDriver Settings Dialog is open.

(2) You are recording, record monitoring, or playing audio in another application.

(3) When using another audio application such as Acid or Cubase VST that has an option to keep the
wave driver "open" even when you are not playing or recording.

Solution / Workaround
Before playing, recording, or record enabling in Cakewalk,❍   

(1) Close the WaveDriver Settings Dialog.

(2) Stop recording, record monitoring, or playing audio in all other applications.

(3) You must either turn off the "always keep the wave driver open" setting in other apps or close the
applications in which this setting is enabled.

 

Minor playback problems after recording

Description
If you have "Enable Simultaneous Record/Playback" checked, you might experience minor playback problems after a
record pass. If you have recorded audio and have not moved the cursor, upon pressing play or record you may hear a
snippet of the audio you just recorded. Note that this is not a glitch in the recorded audio.

❍   

Solution / Workaround
Move the cursor to a new location after each recording, OR❍   

Mute the record enabled track(s) until you are done recording.❍   

 

"Audio extension DLL cannot be found" error

Description
Upon launching Cakewalk, you see an error dialog saying "Audio extension DLL cannot be found."❍   

Solution / Workaround
This error results from having "Digidesign AudioMedia 3" or "Digidesign Session 8" selected as your Audio Hardware in
Cakewalk.

❍   

To change your audio hardware, go to Tools | Audio Hardware in Cakewalk.❍   

In the Audio Hardware dialog, select "Windows Sound Cards (DirectShow 5.1)."❍   

Make sure the remainder of Cakewalk's settings are set to the recommended settings above.❍   



------------------------------------------------------------------------------------------------------------------------------

Sonic Foundry Acid

------------------------------------------------------------------------------------------------------------------------------

Recommended Settings
Go to Options | Preferences.❍   

Select the Audio tab.❍   

Make sure the default playback device is "Digidesign AMIII: Chan 1-2". The default playback device is the first one
available in a track's playback device selector list. (The "playback device selector" is that little number to the left of the
mute button on each track.) If the AMIII is your default playback device, the playback device selector on each track
should say "1".

❍   

By default, you should disable (uncheck) "Keep audio devices open for faster playback startup reponse". Disabling this
allows you to launch an audio editor such as Sound Forge from within Acid without encountering the dreaded "Error
-6010: Cannot Acquire Hardware" errors. If you seldom use an external editor, or if you never use one at the same time
as Acid, you may enable (check) this option for slightly faster response from the driver.

❍   

Set "Playback Buffering (seconds)" to greater than 0.07.❍   

Press the Advanced button.❍   

Select "Playback: Digidesign AMIII: Chan 1-2".❍   

You should not need to interpolate the wave driver's playback position.❍   

Make sure "Do not pre-roll buffers before starting playback" is disabled.❍   

Select "Record: Digidesign AMIII: Chan 1-2".❍   

You should not need to interpolate the wave driver's recording position.❍   

Press OK to close the dialog and save your settings.❍   

 

Glitches during 24-bit playback/recording

Description
The wave driver is compatible with almost all playback buffer sizes in Acid. However, some users may hear glitches in
the audio if they are playing 24-bit audio with very low buffer sizes like 0.05 seconds or have many tracks in their
session. In our tests, we get 6 or more 24-bit tracks and 10 or more 24-bit tracks in Acid 1.0.

❍   

Solutions / Workarounds
Increasing Acid's buffer size to between 0.07 and 0.2 seconds often makes these glitches go away❍   

Go to Options | Preferences and select the General tab. Set "Play files from disk if bigger than (Megabytes)" as large
as possible.

❍   

Decrease the number of tracks in your session or record at 16-bit resolution.❍   

 

Glitches while saving a track during playback/recording

Description
Go to the View menu and select Properties. (The Properties window will appear in the lower left corner by default.)❍   

Play at least one track.❍   

During playback, select one of the audio tracks being played.❍   

In the Properties window, press the disk icon to save the track.❍   

One or both of these things will occur. Audible pops may occur. If so, they would appear in any tracks you are
recording.

❍   

If you are in loop playback, playback will stop (but the counter will continue) after the loop has played through one
more time.

❍   

Solution / Workaround
Stop playback in Acid before saving a track.❍   

Or, if you must save while playing, increase the buffer size in the WaveDriver Settings dialog to help prevent the
audible pops.

❍   



 

Playback stops while generating Midi clock using the Opcode Studio 128X interface

Description
Selecting "Generate MIDI clock" in the Option popup menu (or pressing Shift+F7) during playback stops playback.❍   

Solution / Workaround
Stop playback in Acid before stopping or starting MIDI clock.❍   

 

Glitches while accessing a mounted HFS (Mac-formatted) disk drive

Description
Go to the View menu and select Explorer so you can browse your directories from within Acid.❍   

Play at least one track.❍   

During playback, browse to an HFS volume in Acid's Explorer window and select it.❍   

Audible pops may occur.❍   

Solution / Workaround
Increase the buffer size in the WaveDriver Settings dialog to Medium.❍   

 

Glitches and/or playback stopping when using Acid and Sound Forge together

Description
Play at least one track.❍   

During playback, select one of the audio tracks being played and right-click on its track name.❍   

Select "Edit in Audio Editor." By default the audio editor will be Sound Forge.❍   

You may hear clicks and pops while Sound Forge is launching.❍   

Begin playback within Sound Forge (while playing back in Acid).❍   

One or both of the following error messages will appear.❍   

The wave driver will display "Error -6010: Cannot Acquire Hardware." Sound Forge will display an error dialog that
says the wave driver is in use by another audio application. These dialogs are perfectly normal since the wave driver is
indeed playing back audio in Acid.

❍   

Press OK to close the dialog(s).❍   

Exit Sound Forge.❍   

In Acid, press Stop and then press Play again.❍   

In about two seconds, playback will stop even though the counter is still running.❍   

Solution
Press Stop again.❍   

Save your Acid session and Exit Acid.❍   

Launch Acid again and Open your session.❍   

Try playing back your session.❍   

If you don't hear anything or see another "Error -6010" dialog, Exit Acid again and Restart Windows.❍   

Workaround
Stop playback in Acid before editing a file in Sound Forge or another audio application.❍   

------------------------------------------------------------------------------------------------------------------------------

Sonic Foundry Sound Forge

------------------------------------------------------------------------------------------------------------------------------

Recommended Settings



Go to Options | Preferences.❍   

Select the Wave tab.❍   

Make sure the Playback and Record devices are set to "Digidesign AMIII: Chan 1-2".❍   

You should not need to interpolate the wave driver's playback or recording positions.❍   

Playback and recording position biases should be OK if set to 0.❍   

As a default, you may set "Total buffer size (kilobytes)" at its lowest setting, 64 kB. If you encounter any glitches in
recorded audio, and the wave driver's buffer size is already set to Medium, try increasing Sound Forge's total buffer
size.

❍   

"Preload size (kilobytes)" may be set to 0 kB.❍   

Press OK to close the dialog and save your settings.❍   

 

Audible Pops after using an effects plugin

Description
You may hear a pop the first time a file is played after processing it with an effects plugin.❍   

Solution / Workaround
Increase the buffer size in the WaveDriver Settings dialog to Medium.❍   

------------------------------------------------------------------------------------------------------------------------------

eMagic Logic Audio 3.5, 4.0

------------------------------------------------------------------------------------------------------------------------------

Recommended Settings
In Logic Audio 3.5, go to File | Preferences. In Logic Audio 4.0, go to Audio | Audio Hardware & Devices●   

Select the Audio Extensions tab.●   

PC AV should be checked.●   

"Digidesign AMIII: Chan 1-2" should be your Record and Playback Driver in Logic Audio 3.5 or your Driver in Logic Audio 4.0.●   

Do NOT choose DAE as your Audio Device.●   

If you do not see "Digidesign AMIII: Chan 1-2" in your list of drivers, you probably need to instruct Logic Audio to scan for the
AMIII in your system. (Perhaps you installed or updated the AMIII driver after you had installed Logic.) Please exit Logic Audio
first. Launch the Logic Audio Device Setup app and wait while it configures Logic to work with the AMIII. You should see
"MME Digidesign AMIII: Chan 1-2" in your list of virtual devices. Make sure the driver is Enabled and that the "Full Duplex"
option is checked. You may optionally check "Output Position Only". You should not need to check "Interpolate Position" but it
probably won't hurt. Press OK to save your settings and exit the Device Setup app. Relaunch Logic Audio and select the
AMIII as your driver as described above.

●   

(Logic Audio 3.5 only) Dragging files into the Arrange window causes a crash

This is not a wave driver bug but is such an odd bug in Logic that we thought we'd mention it. This has been fixed in
Logic Audio 4.0.

Description
Create a new session.❍   

Open Audio window and add two audio files.❍   

Open Arrange window.❍   

Drag one file from the Audio window to the Arrange window, and then drag the second file over.❍   

Crash with an exception log: "PAD32 caused an invalid page fault in module Digi32.dll."❍   

Solution / Workaround
Go to the Date/Time control panel and change your time zone to BERLIN.❍   

------------------------------------------------------------------------------------------------------------------------------

Steinberg Cubase VST 3.5, 3.6.5, possibly 3.7

------------------------------------------------------------------------------------------------------------------------------



Recommended Settings
Go to Audio | System.❍   

In the Audio System dialog, click on the ASIO control panel button.❍   

For VST 3.6.5: In the ASIO Multimedia setup dialog, press the Advanced Options button.❍   

Make sure "Digidesign AMIII: Chan 1-2" is enabled for both input and output ports.❍   

Under Card Options, make sure "full duplex" and "open all devices before start" are both checked/enabled.❍   

Make sure the Sync Reference is set to "Sample Position -- Output".❍   

 

Pressing "Detect Buffer Size" results in an error

Description
In VST 3.6.5's "ASIO Multimedia Setup: Advanced Options" dialog, pressing the Detect Buffer Size button while the
wave driver is in 24-bit mode results in the following error:

❍   

"ASIO Multimedia Driver, Errorcode: FF8-7-0026, Info: Playback Failed. The audio system does not seem to respond.
Maybe the card does not support full duplex mode."

❍   

Solution / Workaround
This error dialog results from a minor incompatibility between the wave driver and Cubase VST. Full-duplex operation
DOES work in 24-bit mode, so this error message may be safely ignored. All other tests of the wave driver from within
Cubase VST will succeed if you have followed the recommended settings above. Steinberg agreed to fix this bug after
VST 3.7.

❍   

------------------------------------------------------------------------------------------------------------------------------

Microsoft ActiveMovie Player

------------------------------------------------------------------------------------------------------------------------------

Delay after playback and pops when using default wave file player

Description
If you right-click on a wave file from Explorer and select Play, the ActiveMovie Player will launch by default to play the
wave file.

❍   

The wave file will not begin playing for a few seconds, during which time you may hear several small pops.❍   

After this delay, the file will play back correctly.❍   

When the file is done playing, you may hear more small pops if you click the mouse pointer in the playback area of the
ActiveMovie window.

❍   

Solution / Workaround
No workaround exists other than choosing another application to be your default wave file player.❍   

To choose another default wave file player, Launch Windows Explorer.❍   

Go to the View | Options menu.❍   

Select the Files Types tab.❍   

Scroll down the list and select Wave Sound.❍   

Press the Edit button.❍   

Associate your new wave file player with the Open and Play events.❍   

Press OK to close all dialogs and save your settings.❍   

------------------------------------------------------------------------------------------------------------------------------

Real Networks RealPlayer G2

------------------------------------------------------------------------------------------------------------------------------

RealPlayer's volume and mute controls do not work

Workaround
Use the DigiGain volume control application.❍   



------------------------------------------------------------------------------------------------------------------------------

Steinberg ReBirth 2.01, possibly other applications

------------------------------------------------------------------------------------------------------------------------------

After installing ReBirth and restarting Win98, you get a DigiProx error saying it can't run with this version of
msvcrt.dll.

Description
DigiProx.exe is a file that was installed with the wave driver. It requires the newest version of msvcrt.dll (6.00.XXX), a
shared Microsoft DLL. The ReBirth installer installs an older version of msvcrt.dll (5.0.XXX) which is not compatible
with DigiProx.

❍   

Solution / Workaround
ReBirth will work with the newer version of msvcrt.dll. The easiest way to reinstall this newer file is to leave your
ReBirth installation as is, remove the wave driver, and then reinstall the wave driver. (Msvcrt.dll 6.00.8397.0 is installed
as part of the wave driver installation.) Please follow the relevant directions above under "Removing the WaveDriver"
and "Installation Instructions".

❍   


